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Chuo-ku, Tokyo 103-8666,
JAPAN

Mini compact
Design

The thinnest is only 10.5cm. The 
combined connector are hidden 

beside the machine, which is 
easy and beautiful.

Tank-less
Design

Easy to use and directly to drink. 
Enjoy every fresh water in your 

wonderful life.

NanoPad
KUSATSU Water filter

Professional
Nano Filtration
Using professional Nano filtration membrane 

and three pre-filter cartridge, effectively 
remove all kinds of impurities and pollutants 
in water, such as organics, micro organism, 

virus, metal ions, radioactive ions.

ABS Food-Grade
Material

Compact body, it simple, easy to 
clean and safety.

Saving water by
Every Drop

Every 10L can have 8.5L pure 
clear water

Protecting your
drinking water

The item can show you the lifetime of 
each cartridge through LED display 

screen. Protecting your drinking 
water by changing cartridge time to 

time.

KUSATSU Brand New NanoPad water filter, 10.5cm thin, the 
thinnest water filter you could ever imagine. Simple and fashion 

white compact body with black surface, its beauty and design are   
beyond all other normal filter.



» Filter lifespan (PP&CTO&T33): 2000L
» Pure Water Flow : 1.2L/Min
» Machine lifespan (PP&CTO&T33): 2000L
» Four stage Filtration
» Filtration replacement reminder
» No tubes or adaptors inside
» Advanced bayonet cartridge filter
» Auto shutoff water during filter replacement

Features

The latest card buckle filter
Auto Shut-off

» Auto Flush
» On Board Computer
» Pure Water Flow : 0.8 ~ 1.2L/Min
» Luxury Faucet : GF-02C
» No Tank Needed, Enjoy fresh pure water at any time
» Machine Dimension : 435x390x105mm
» Packing Dimension : 475x435x210mm

Features

» 1st Stage : PP Sediment Filter
» 2nd Stage : Carbon Block Filter
» 3rd Stage : Kusatsu Toray RO
                          Membrane

Process

» 1st Stage : PP Sediment Filter
» 2nd Stage : Carbon Block Filter
» 3rd Stage  : Iodized Resin Filter
» 4rd Stage : UF Membrane
» 5th Stage  : Activated Carbon

Process

Compact body, Elegant appearance,
Save space effectively

Ultra-low waste water ratio
1/3 less than traditional systems

Wifi Controller
Easy Operation

» On Board Computer
» Pure Water Flow : 1.8 ~ 2.5L/Min
» Quick Fitting
» Luxury Faucet : GF-02C
» No Tank Needed, Enjoy fresh pure water at any time
» Machine Dimension : 435x390x105mm
» Packing Dimension : 475x435x210mm

Features



» No Need Electricity
» 4-Stage Filtration With UF
» Mini Compact Design
» All Bayonet Cartridges
» With two doors at both sides
» Easily replaceable cartridge
» Packing Dimension : 372x245x410mm

Features

» Auto Flush
» Water output : 50G/75G
» 5-Stage Filtration With RO
» With Stable Holding Shelf
» Bayonet RO Membrane Element
» Pressure Tank : 3.2G Steel Tank or 3.0G Plastic Tank
» Packing Dimension : 560x310x440mm

Features
» Instant heating
» Four temperature to adjust
» 70 seconds Screen shows
» Filters replacement reminder
» Working situation display
» Two sources of raw water
» Child Lock
» Output Quantity
» Shutdown protection when lack water
» Shutdown Protection when replacing filter
» Protect pump from “Run Dry”
» Working Display-water shortage, Purifying, Flushing
» Output temperature display (Adjustable)
» Output water regulation (Adjustable)
» Input water & output water TDS display
» Filtration lifespan display

Features

» Pure Water Flow : 450ml/min
» Raw Water Tank : 5L
» Pure Water Tank : 2L
» Three filters : PP CTO RO
» Size : 440x190x375mm

RO-100G-T03/T04

RO-100G-T03 RO-100G-T04



» With Automatic Shutoff Device When Cartridge Replace
» Change Filter in Seconds without Tools
» Energy Saving, Environment Protection
» Attractive new design
» Small size & Easy Operation
» Fitting type : Quick Fitting
» Packing Dimension : 555x345x345mm/ 10pcs

Features

» With Automatic Shutoff Device When Cartridge Replace
» Change Filter in Seconds without Tools
» Energy Saving, Environment Protection
» Attractive new design
» Small size & Easy Operation
» High Quality PP & CTO Filter
» Fitting type : Quick Fitting
» Packing Dimension : 555x345x345mm/ 10pcs

Features

» With Automatic Shutoff Device When Cartridge Replace
» Change Filter in Seconds without Tools
» Energy Saving, Environment Protection
» Attractive new design
» Small size & Easy Operation
» NSF Standard UF Membrane
» Fitting type : Quick Fitting
» Packing Dimension : 590x345x380mm/ 5pcs

Features

» No Need Electricity
» Easy Installation
» Date dial-up Plate
» Machine Dimension :
   270x85x295mm

Features
» No Need Electricity
» Easy Installation
» Date dial-up Plate
» Machine Dimension :
   190x85x295mm

Features
» No Need Electricity
» Easy Installation
» Date dial-up Plate
» Machine Dimension :
   90x85x295mm

Features



» With Automatic Shutoff Device When Cartridge Replace
» Change Filter in Seconds without Tools
» Energy Saving, Environment Protection
» Attractive new design
» Small size & Easy Operation
» High Quality UF Membrane
» Fitting type : Quick Fitting
» Packing Dimension : 380x175x345mm

Features

» With Automatic Shutoff Device When Cartridge Replace
» Change Filter in Seconds without Tools
» Energy Saving, Environment Protection
» Attractive new design
» Small size & Easy Operation
» High Quality UF Membrane
» Fitting type : Quick Fitting
» Machine Dimension : 330x115x330mm
» Packing Dimension : 380x175x345mm

Features

» Auto Flush
» water Output : 50G/ 75G
» E4-Stage Filtration With RO
» Dustproof Design
» Bayonet RO membrane element
» Pressure Tank : 3.0G Plastic Tank
» Packing Dimension : 435x210x215mm

Features

» TDS Display
» Cartridge Change Reminder



» Bayonet Cartridges
» On Board Computer
» UF or RO System for Option
» With Ultrafiltration & Reverse Osmosis System
» RO Water Output : 50GPD/75GPD/80GPD/100GPD/125GPD
» Pressure Tank : 3.2G Steel Tank or 3.0G Plastic Tank
» Machine Dimension : 370x365x250mm
» Packing Dimension : 530x430x430mm

Features

» Bayonet Cartridges
» TDS & On Board Computer
» Auto Flush
» RO Water Output : 50GPD/75GPD/80GPD/100GPD/125GPD
» Quick Fitting
» Pressure Tank : 3.2G Steel Tank or 3.0G Plastic Tank
» Machine Dimension : 400x415x225mm
» Packing Dimension : 530x430x430mm

Features

» Auto Flush
» RO Water Output : 50GPD/75GPD/80GPD/100GPD/125GPD
» Bayonet Cartridges
» Quick Fitting
» Pressure Tank : 3.2G Steel Tank or 3.0G Plastic Tank
» Packing Dimension : 405x295x500mm

Features

» Manual Flush
» RO Water Output : 50GPD/75GPD/80GPD/100GPD/125GPD
» Bayonet Cartridges
» Quick Fitting
» Pressure Tank : 3.2G Steel Tank or 3.0G Plastic Tank
» Note : Inlet pressure should be equal to or above 87 psi
» Packing Dimension : 405x295x500mm

Features

» Manual Flush
» RO Water Output : 50GPD/75GPD/80GPD/100GPD/125GPD
» Bayonet Cartridges
» Quick Fitting
» Without Pump
» Pressure Tank : 3.2G Steel Tank or 3.0G Plastic Tank
» Note : Inlet pressure should be equal to or above 87 psi
» Packing Dimension : 405x295x500mm

Features



» High Flow, Without Tank
» 3 Stages Filtration : PP, MTP, RO
» RO Water Output : 400GPD
» Quick Fitting
» Big blue bayonet cartridge
» Change filter in seconds without tools
» Packing Dimension : 430x240x475mm

Features
» High Flow, Without Tank
» 3 Stages Filtration : PP, MTP, RO
» RO Water Output : 400GPD
» Filter Compatible as Everpure
» Bigblue bayonet cartridge
» Change filter in seconds without tools
» Packing Dimension : 395x485x510mm

Features



» Mixing Filter Cartridges
» Filter Compatible with Everpure
» Mini Compact design, Big Flow
» Easily Replacable cartridge
» Small size & Easy Operation
» Packing Dimension : 375x470x455mm /6pcs

Features » Calcium sulfite ball :
    Chlorine, Adjust the water PH, make the water weak alkaline
» Activated carbon :
    Can effectively remove the peculiar smell, residual chlorine,
    and absorb the organic matter in water
» KDF :
    Is used to treat heavy metal impurity, and bacteria inhibition
» UF Membrane :
    Remove the suspended solids, colloid, particles, bacteria

4-stages filtration : Mixing Filter Cartridges

» Granular Activated Carbon
» Packing Dimension :
    520x480x455mm/ 16Pcs

GAC-10BF
» PP Sediment
» Packing Dimension :
    520x480x455mm/ 16Pcs

PP-10BF
» Block Activated Carbon
» Packing Dimension :
    520x480x455mm/ 16Pcs

CTO-10BF

» Ultra Filtration
» Packing Dimension :
    520x480x455mm/ 16Pcs

GAC-10BF
» Inline Activated Carbon
» Packing Dimension :
    520x480x455mm/ 16Pcs

T33-10BF
» Reverse Osmosis Filtration
» Packing Dimension :
    520x480x455mm/ 16Pcs

RO-10BF



» 4-stage compact RO System : PP, GAC, CTO, RO
» Pure Water Flow : 1.2L/Min
» No Tank Needed, Enjoy Fresh Water at Any Time
» On Board Computer with Cartridge Reminder
» Lower Waste water ratio : 1:1
» Smaller bu Smater
» Wifi Function : Check Working State & TDS at any Time through your phone App
» Machine Dimension : 390x235x385mm
» Packing Dimension : 550x285x460mm

Features
» 4-stage compact RO System : PP, GAC, CTO, RO
» Pure Water Flow : 1.2L/Min
» No Tank Needed, Enjoy Fresh Water at Any Time
» On Board Computer with Cartridge Reminder
» Lower Waste water ratio : 1:1
» Smaller but Smarter
» Wifi Function : Check Working State & TDS at any Time through your phone App
» Machine Dimension : 390x235x385mm
» Packing Dimension : 550x285x460mm

Features
» 5-stage compact RO System
» External Adaptor
» RO Water Output : 50/75/80/100/125GPD
» Quick Fitting
» Build-in Tank : 2.5G Smart Tank
» Packing Dimension : 590x272x460mm

Features



» 4-stage compact RO System
» TDS & On Board Computer
» External Adaptor
» RO Water Output : 50GPD/75GPD/80GPD/100GPD/125GPD
» Quick Fitting
» Pressure Tank : 2.0G Steel Tank
» Packing Dimension : 485x460x295mm

Features

» 5-stage compact RO System
» TDS & On Board Computer
» External Adaptor
» RO Water Output : 50GPD/75GPD/80GPD/100GPD/125GPD
» Quick Fitting
» Pressure Tank : 2.0G Smart Tank
» Machine Dimension : 450x240x400mm
» Packing Dimension : 500x300x525mm

Features

» 5-stage compact Nanofiltration System
» TDS & On Board Computer
» External Adaptor
» NF Water Output : 500GPD
» Kusatsu Nanofiltration Membrane
» Machine Dimension : 450x240x400mm
» Packing Dimension : 500x300x525mm

Features



» TDS Display
» On Board Computer
» UV Sterilizer for Option
» RO Water Output : 50GPD/75GPD/80GPD/100GPD/125GPD
» Quick Fitting
» Diaphragm Booster Pump With Adaptor 110V/220V, 50/60Hz
» Pressure Tank : 2.5G Smart Tank
» Machine Dimension : 450x240x410mm
» Packing Dimension : 500x300x525mm

Features

» Pressure Gauge
» RO Water Output : 50GPD/75GPD/80GPD/100GPD/125GPD
» Quick Fitting
» Diaphragm Booster Pump With Adaptor 110V/220V, 50/60Hz
» Pressure Tank : 2.5G Smart Tank
» Machine Dimension : 450x240x410mm
» Packing Dimension : 500x300x525mm

Features

» TDS Display
» On Board Computer
» RO Water Output : 50GPD/75GPD/80GPD/100GPD/125GPD
» Quick Fitting
» Diaphragm Booster Pump With Adaptor 110V/220V, 50/60Hz
» Pressure Tank : 3.2G Steel Tank or 3.0G Plastic Tank
» Machine Dimension : 450x240x410mm
» Packing Dimension : 500x300x525mm

Features

» Compact RO
» RO Water Output : 50GPD/75GPD/80GPD/100GPD/125GPD
» Quick Fitting
» Diaphragm Booster Pump With Adaptor 110V/220V, 50/60Hz
» Pressure Tank : 2.5G Smart Tank
» Machine Dimension : 450x240x410mm
» Packing Dimension : 500x300x525mm

Features

» With source water tank, you can put this dispenser anywhere you want
» 3-Stage RO system : PP, CTO, RO
» Large LED dsiplay screen
» Separate holding tanks
» Source water tank (11L)
» Ambient : 5L
» Hot : 1.8L
» Cold : 1.8L
» Cooling by Compressor
» Children Lock, it can lock the Hot water button
» Machine Dimension : 36x34x110cm
» Packing Dimension : 40x42x116cm

Features



» Water Dispenser
» Large LED Display Screen
» Separate Holding Tanks :
    Ambient : 5L
    Hot : 1.8L
    Cold : 1.8L
» Cooling by Compressor
» Children lock, it can lock the hot watter button
» Nice Cabinet
» Machine Dimension : 36x34x110mm
» Packing Dimension : 40x42x116mm

Features
» RO System Inside
» Large LED Display Screen
» Separate Holding Tanks :
    Ambient : 5L
    Hot : 1.8L
    Cold : 1.8L
» Cooling by Compressor
» Children lock, it can lock the hot watter button
» Nice Cabinet
» Machine Dimension : 36x34x110mm
» Packing Dimension : 40x42x116mm

Features
» Ultrafiltration System Inside
» Large LED Display Screen
» Separate Holding Tanks :
    Ambient : 5L
    Hot : 1.8L
    Cold : 1.8L
» Cooling by Compressor
» Children lock, it can lock the hot watter button
» Nice Cabinet
» Machine Dimension : 36x34x110mm
» Packing Dimension : 40x42x116mm

Features
» Pipeline Water Filter Dispenser
    (Can Choose RO System or Ultrafiltration System)
» Touch Panel
» Separate Holding Tanks :
    Ambient : 5L
    Hot : 1.8L
    Cold : 1.8L
» Cooling by Compressor
» Children lock, it can lock the hot watter button
» Nice Cabinet
» Machine Dimension : 36x34x110mm
» Packing Dimension : 40x42x116mm

Features



» Pipeline Water Dispenser
» Separate Holding Tanks
    Pure Water : 5L
    Hot Water : 1.8L
    Cold Water : 1.8L
» Cooling by Compressor
» Refrigerated Cabinet
» Machine Dimension : 40x42x116cm

Features
» Pipeline Water Filter Dispenser
    (with RO System)
» Separate Holding Tanks
    Hot Water : 1.8L
    Cold Water : 1.8L
» Cooling by Compressor
» Refrigerated Cabinet
» Machine Dimension :
    500x465x1390mm

Features
» Pipeline Water Filter Dispenser
    (with UF System)
» Separate Holding Tanks
    Hot Water : 1.8L
    Cold Water : 1.8L
» Cooling by Compressor
» Refrigerated Cabinet
» Machine Dimension :
    500x465x1390mm

Features



» Water Dispenser
» Large LED Display Screen
» Separate Holding Tanks :
    Pure Water : 5L
    Hot Water : 1.8L
    Cold Water : 1.0L
» Cooling by PTC
» Water Leakage Protection
» Water Leak Alarm
» Children Lock,
    it can lock the watter button
» Machine Dimension : 36x34x56cm
» Packing Dimension : 39x41x64cm

Features
» RO System Inside
» Large LED Display Screen
» Separate Holding Tanks :
    Ambient : 5L
    Hot Water : 1.8L
    Cold Water : 1.0L
» Cooling by PTC
» Water Leakage Protection
» Water Leak Alarm
» Children Lock,
    it can lock the watter button
» Machine Dimension : 36x34x56cm
» Packing Dimension : 39x41x64cm

Features
» Ultrafiltration System Inside
» Large LED Display Screen
» Separate Holding Tanks :
    Ambient : 5L
    Hot Water : 1.8L
    Cold Water : 1.0L
» Cooling by PTC
» Water Leakage Protection
» Water Leak Alarm
» Children Lock,
    it can lock the watter button
» Machine Dimension : 36x34x56cm
» Packing Dimension : 39x41x64cm

Features

» With IC Controller
» LCD Screen Accurately Display Hot & Cold Water
» Fitting Type : Quick Fitting
» Electricity Leakage Protection
» Heating by EGO
» With Hot, Pure, Cool Water
    Hot Water Tank : 5L
    Pure Water Tank : 25L
    Cool Water Tank : 3L
» Water Output : 200GPD/300GPD/400GPD
» Machine Dimension : 50x58x150cm

Features
» With IC Controller
» LCD Screen Accurately Display Hot & Cold Water
» Fitting Type : Quick Fitting
» Electricity Leakage Protection
» Heating by EGO
» With Hot, Pure, Cool Water
    Hot Water Tank : 5L
    Pure Water Tank : 25L
    Cool Water Tank : 3L
» Water Output : 200GPD/300GPD/400GPD
» Machine Dimension : 50x58x150cm

Features



» Room-temperature, Hot Water
» Rated Power : 3000W
» Heating Power : 3000W
» Hot : 20L
» Rated Voltage : 220V
» Rated Frequency : 50Hz/60Hz
» Machine Dimension : 40x38x132cm

HL-3A
» Room-temperature, Hot Water
» Rated Power : 3000W
» Heating Power : 3000W
» Hot : 20L
» Rated Voltage : 220V
» Rated Frequency : 50Hz/60Hz
» Machine Dimension : 48x43x160cm

HL-3B
» Room-temperature, Hot Water
» Rated Power : 1200W
» Heating Power : 900W
» Cooling Power : 110W
» Hot : 5L
» Cold : 5L
» Rated Voltage : 220V
» Rated Frequency : 50Hz/60Hz
» Machine Dimension : 40x38x132cm

HL-3C

» Instant Use
» Intelligent Control
» Saving Energy and Protecting Environment
» Automatic temperature stabilization technology

Features

HZ-120KHZ-90KHZ-60KHZ-40K

Water Volume
Supplying hot water
Power Supply
Voltage
Packing Dimension
(L x W x H (cm))

Model
15L 15L 32L 32L

40L/H 60L/H 90L/H 120L/H
3000W 6000W 9000W 12000W

220V~50Hz 380V~50Hz 380V~50Hz 380V~50Hz

40x48x124 40x48x124 50x48x132 50x50x137



» Small Size & Easy Operation
» Attractive New Design
» Auto Flush
» RO Water Output :
    50GPD/75GPD/80GPD/100GPD/125GPD
» Diaphragm Booster Pump
    with Adaptor 110V/220V, 50/60Hz
» Quick Fitting
» Pressure Tank : 3.2G Steel Tank or 3.0G Plastic Tank
» Machine Dimension : 310x155x480mm
» Packing Dimension : 355x185x560mm

Features

» Small Size & Easy Operation
» Attractive New Design
» Auto Flush
» RO Water Output : 50GPD/75GPD/80GPD/100GPD/125GPD
» Diaphragm Booster Pump with Adaptor 110V/220V, 50/60Hz
» Quick Fitting
» Pressure Tank : 3.2G Steel Tank or 3.0G Plastic Tank
» Machine Dimension : 335x145x430mm
» Packing Dimension : 445x440x350mm

Features



» Auto Flush
» No Waste Water
» RO Water Output :
    50GPD/75GPD/80GPD/100GPD/125GPD
» Fast-Fit Cartridges : PP, GAC, CTO, T-33
» Special Pressure Tank and Valve
» Packing Dimension : 340x95x440mm

Features

» Small Size & Easy Operation
» Attractive New Design
» High Quality UF Membrane
» Energy Saving, Environment Protection
» Fitting Type : Quick Fitting
» Machine Dimension : 415x90x335mm
» Packing Dimension : 340x95x440mm

Features

» 5-stage RO System : PP, GAC, CTO, RO, T33
» On Board Computer
» Dustproof design
» RO water Output :
    50G/75G/80G/100GPD
» Diaphragm Booster Pump
    With adaptor 110V/220V, 50/60Hz
» 3.0G Plastic tank or 3.2G Steel Tank for Option
» Water Leakage Protection
» Two Colors for Option
» Packing Dimension : 515x465x610mm

Features



» 4-Stage RO System : PP, GAC, RO, T33
» No Tank Needed, Enjoy fresh water instantly
» Children lock function protect children from hot water
» RO water output : 50G/75G/80G/100G
» Ambient : 4.5L
» Hot : 1.5L
» Packing Dimension : 675x270x480mm

Features

» Safety : Electricity & Water Separated
» Health : Drinking Upon Heating
» Energy Conversation : Vacum Heat Preservation
» Convenience : Big Flow Rate, Intelligent Control
» Packing Dimension : 35x45x11.6mm

Features

» Hot & Warm Water
» Directly Pipeline Water Dispenser, Avoid
    Secondary Pollution
» Light Indicator
» Suitable for Family, Office Use
» Attractive Design, Small Size & Easy Operation
» Packing Dimension : 32x19x44cm

Features

» Instant Heating Pipeline Water Dispenser
» No Hot Tank : Drinking Upon Heating
» Instant Heating Technology
» Food Grade Water Supply
» Temperature Indicating
» Intelligent Temperature Control
» Overheating Protection
» Touch Panel
» Quantitive Water
» Packing Dimension : 35.5x18.5x47cm

Features

» Hot & Warm Water
» Directly Pipeline Water Dispenser, Avoid
    Secondary Pollution
» Light Indicator
» Suitable for Family, Office Use
» Attractive Design, Small Size & Easy Operation
» Packing Dimension : 35.5x18x48cm

Features



» OnBoard Computer
» Dustproof of Design
» Cartridges Change Reminder
» RO Water Output : 50GPD/75GPD/80GPD/100GPD/125GPD
» Quick Fitting
» Diaphragm Booster Pump With Adaptor 110V/220V, 50/60Hz
» Pressure Tank : 3.2G Steel Tank or 3.0G Plastic Tank
» Machine Dimension : 390x210x490mm
» Packing Dimension : 440x360x580mm

Features

» OnBoard Computer
» Dustproof of Design
» Cartridges Change Reminder
» RO Water Output : 50GPD/75GPD/80GPD/100GPD/125GPD
» Quick Fitting
» Diaphragm Booster Pump With Adaptor 110V/220V, 50/60Hz
» Pressure Tank : 3.2G Steel Tank or 3.0G Plastic Tank
» Machine Dimension : 390x210x490mm
» Packing Dimension : 440x360x580mm

Features



» High Flow, without Tank
» RO Water Output :
    200GPD/400GPD/600GPD
» Quick Fitting
» Machine Dimension : 400x220x480mm
» Packing Dimension : 420x415x465cm

Features

» 5-stage RO System :
    PP, GAC, CTO, RO, T33
» Pure Water Flow : 1.2L/min
» No Tank Needed, Enjoy Fresh
     Water Instantly
» On Board Computer
» Lower Waste Water Ratio : 1:1
» Packing Dimension :
    400x280x530mm

Features

» Auto Shutoff Float Switch
» Compact & Elegant
» RO water Output :
    50GPD/75GPD/80GPD/100GPD/125GPD
» Quick Fitting inline Cartridge
» Diapghram Booster Pump
     with Adapter 110/220V, 50/60Hz
» Built in Water Tank 5.8 Liter
» Counter Top Application
» Packing Dimension : 375x290x520cm

Features
RO-50G/75G/80G/100G/125G-X02

» Auto Shutoff Float Switch
» Compact & Elegant
» RO water Output :
    50GPD/75GPD/80GPD/100GPD/125GPD
» Quick Fitting inline Cartridge
» Diapghram Booster Pump
     with Adapter 110/220V, 50/60Hz
» Built in Water Tank 7.0 Liter
» Counter Top Application
» Machine Dimension : 350x315x535cm
» Packing Dimension : 315x385x570cm

Features
RO-50G/75G/80G/100G/125G-X01

» Manual Flush
» RO Water Output :
    50GPD/75GPD/80GPD/100GPD/125GPD
» Quick Fitting
» Diaphragm Booster Pump
    with Adaptor 110V/220V, 50/60Hz
» Pressure Tank : 3.2G Steel Tank
    or 3.0G Plastic Tank
» Machine Dimension : 400x220x480mm
» Packing Dimension : 520x400x470mm

Features



» Manual Flush
» RO Water Output :
    50GPD/75GPD/80GPD/100GPD/125GPD
» Housing : 122-10Y-W Single “O” Ring Housing
» Quick Fitting
» Diaphragm Booster Pump With
    Adaptor 110V/220V, 50/60Hz
» Pressure Tank : 3.2G Steel Tank or 3.0G Plastic Tank
» Machine Dimension : 360x145x440mm
» Packing Dimension : 440x360x580mm

Features

» Manual Flush
» RO Water Output :
    50GPD/75GPD/80GPD/100GPD/125GPD
» Housing : 122-10Y-W Single “O” Ring Housing
» Quick Fitting
» Without Pump
» Pressure Tank : 3.2G Steel Tank or 3.0G Plastic Tank
» Note : Inlet Pressure should be Equal to above 87 psi
» Packing Dimension : 420x290x560mm

Features

» Auto Flush
» On Board Computer :
» First Stage : PP Filter, removes sediments and large particles
» Second Stage : Activated Carbon Filter, Removes Chlorine
    and odor
» Third Stage : RO Membrane, removes bacteria, 
    Heavy metals, dissolved matter, and salinity
» Forth Stage : Resin Cartridge, removes calcium and
    Magnesium ions to generate soft water
» Packing Dimension : 430x370x580mm

Features

» RO Water Output : 50GDP/75GDP/80GPD/100GPD/125GDP
» Housing : 122-10Y-W Single “O” Ring Housing
» Quick Fitting
» Without Pump
» Pressure Tank : 3.2G Steel Tank or 3.0G Plastic Tank
» Note : Inlet Pressure Should be Equal to or Above 87 psi
» Packing Dimension : 430x370x580mm

Features

» 6th Stage : Medicinal Stone
» Manual Flush
» RO Water Output :
    50GPD/75GPD/80GPD/100GPD/125GPD
» Housing : 122-10Y-W Single “O” Ring Housing
» Quick Fitting
» Diaphragm Booster Pump With
    Adaptor 110V/220V, 50/60Hz
» Pressure Tank : 3.2G Steel Tank or 3.0G Plastic Tank
» Machine Dimension : 360x145x440mm
» Packing Dimension : 440x360x580mm

Features

» 6th Stage : Ultraviolet water sterilizer
» Manual Flush
» RO Water Output :
    50GPD/75GPD/80GPD/100GPD/125GPD
» Housing : 122-10Y-W Single “O” Ring Housing
» Quick Fitting
» Diaphragm Booster Pump With
    Adaptor 110V/220V, 50/60Hz
» Pressure Tank : 3.2G Steel Tank or 3.0G Plastic Tank
» Machine Dimension : 360x145x440mm
» Packing Dimension : 440x360x580mm

Features

» TDS & On Board Computer
» RO Water Output :
    50GPD/75GPD/80GPD/100GPD/125GPD
» Housing : 122-10Y-W Single “O” Ring Housing
» Quick Fitting
» Diaphragm Booster Pump With
    Adaptor 110V/220V, 50/60Hz
» Pressure Tank : 3.2G Steel Tank or 3.0G Plastic Tank
» Machine Dimension : 360x145x440mm
» Packing Dimension : 440x360x580mm

Features



» On Board Computer
» Auto Flush
» Pressure Gauge
» Housing : 122-20 Single “O” Ring Housing
» RO Water Output :
    100GPD/200GPD/400GPD/600GPD/800GPD
» Fitting Type : JACO
» Diaphragm Booster Pump
    with Adaptor 110V/220V, 50/60Hz
» Pressure Tank : 11G Steel Tank
» Packing Dimension : 60x60x155cm

Features

» On Board Computer
» Auto Flush
» Pressure Gauge
» Housing : 122-20 Single “O” Ring Housing
» RO Water Output :
    100GPD/200GPD/400GPD/600GPD/800GPD
» Fitting Type : JACO
» Diaphragm Booster Pump
    with Adaptor 110V/220V, 50/60Hz
» Pressure Tank : 11G Steel Tank
» Packing Dimension : 61x61x100cm

Features

» 1st Stage :
     PP Filter removes sediment
     and large particles
» 2nd Stage :
    Activated Carbon Filter Removes
    Chlorine and odor
» 3rd Stage :
    RO Membrane removes bacteria,
    Heavy metals, Dissolved matter,
    and salinity
» Packing Dimension : 37x22.5x13cm

Process

» RO Water Holding
» Tank for water Dispenser
» Capacity : 4L
» Packing Dimension :
    405x405x410mm /8pcs

DPT-001

» 1st Stage :
     PP Filter removes sediment
     and large particles
» 2nd Stage :
    RO Membrane removes bacteria,
    Heavy metals, Dissolved matter,
    and salinity
» 3rd Stage :
    Resin removes residual traces of
    pesticides and hydrocarbon 
    contaminates
» Faucet : GF-01
» Packing Dimension : 420x350x580mm

Process
» BP-01
» QAD-01
» PP-33
» GAC-33
» CTO-33
» T-33
» T-300
» Kusatsu or Filmtec
» GF-02C
» TR-420-1
» TDS-1

Process 5 Stage Filtration
Booster Pump (50G)  x1

Adaptor (50G)  x1
PP spun fiber filter  x1

Granular carbon filter  x1
Block carbon filter  x1

Activated carbon filter  x1
Flow-limit valve  x1

RO Membrane (50G)  x1
Goose faucet  x1

Water electrolyzer  x1
TDS Meter  x1

» RO Water Holding
» Tank for water Dispenser
» Capacity : 8L
» Packing Dimension :
  540x530x450mm /8pcs

DPT-002

» Remove water bottle and Holder
» Install Dispenser Holding Tank
» Connect Tank to RO unit

Usage

Use the Dispenser Holding Tank to reduce
Cost and Enjoy Pure RO water from the
Convenience of your water cooler



» On Board Computer
» Auto Flush
» Pressure Gauge
» Housing : 122-20 Single “O” Ring Housing
» RO Water Output : 200GPD/400G GPD
» Fitting type : JACO
» Diaphragm Booster Pump with
    Adaptor 110V/220V, 50/60Hz
» Pressure Tank : 11G Steel Tank
» Packing Dimension : 59x42x99cm

Features

» Flush type : Manual Flush
» With steel shelf
» Housing : 122-20 Single “O” Ring Housing
» RO Water Output : 200GPD/400G GPD
» Fitting type : JACO
» Diaphragm Booster Pump with
    Adaptor 110V/220V, 50/60Hz
» Pressure Tank : 11G Steel Tank
» Packing Dimension : 45.5x29x80cm

Features

» Flush type : Manual Flush
» With steel shelf
» Housing : 122-20 Single “O” Ring Housing
» RO Water Output : 200GPD/400G GPD
» Fitting type : JACO
» Diaphragm Booster Pump with
    Adaptor 110V/220V, 50/60Hz
» Pressure Tank : 11G Steel Tank
» Packing Dimension : 47x31x88cm

Features

» On Board Computer
» Auto Flush
» Pressure Gauge
» Housing : 122-20 Single “O” Ring Housing
» RO Water Output :
    100GPD/200GPD/400GPD/600GPD/800GPD
» Fitting type : JACO
» Diaphragm Booster Pump with
    Adaptor 110V/220V, 50/60Hz
» Pressure Tank : 11G Steel Tank
» Packing Dimension : 53x44x106cm

Features

» On Board Computer
» Auto Flush
» Pressure Gauge
» Housing : 122-20 Single “O” Ring Housing
» RO Water Output :
    100GPD/200GPD/400GPD/600GPD/800GPD
» Fitting type : JACO
» Diaphragm Booster Pump with
    Adaptor 110V/220V, 50/60Hz
» Pressure Tank : 11G Steel Tank
» Packing Dimension : 53x63x126cm

Features



» Three levels protection, no leakage
» Variety of faucet converters,
    meet different models of faucets
» Energy Saving, Environment Protecting
» Quick Fitting
» Packing Dimension : 11x5.5cm

Features

» Hybrid Filter Element
» Filtration Precision is about 0.01 Micron
» Bacterial removes rates can reach up of 99.99%
» Cleaner, Healthier, Tastier
» Packing Dimension : 305x215x78mm

Features

» Adopt the Environmental Material in conformity with Food Grade standard
» Light bootle design with screw type, easy to twist from the device and more
    Convenient for every use
» Only three-second production time enables sparkling water much more tasty

Features

» Calcium Sulfite Ball : remove the residual chlorine, Adjust the
    water PH, make the water weak alkaline
» Activated Carbon : can effectively remove the peculiar smell, residual
    chlorine, absorb the organic matter in water
» KDF : is used to treat heavy metal impurity, and bacteria inhinition
» UF Membrane : remove the suspended solids, colloid, particles, bacteria

» Calcium Sulfite Ball : remove the residual chlorine, Adjust the
    water PH, make the water weak alkaline
» Coconut Carbon : can effectively remove the peculiar smell, residual
    chlorine, absorb the organic matter in water
» Soften Resin : Reduce the hardness of watter, improve the water taste
» Mixed Resin : Remove the heavy metals in water, can reduce TDS value
    of tap water, improve water purity
» UF Membrane : remove the suspended solids, colloid, particles, bacteria
    and other harmful substances in the water

» Multi-Fuction Cartridge, Drinking Directly
» PP, Lodized Resin, Coconut Carbon, UF Membrane
» Pocketable, Easy Operation
» No Need Electricity
» Bag Capacity : 10L
» Service life : 500L
» Packing Dimension : 350x140x75mm

Features

» Pure Water Flow : 200-250ml/min
» Cleaner, Healthier, Tastier
» Easily Replaceable Reminder
» Cartridge Replacement Reminder
» Pitcher Capacity : 3.0L
» Packing Dimension : 300x170x280mm

Water Pitcher
» Pure Water Flow : 200-250ml/min
» Cleaner, Healthier, Tastier
» Easily Replaceable Reminder
» Cartridge Replacement Reminder
» Pitcher Capacity : 2.5L
» Packing Dimension : 225x125x250mm

Water Pitcher
» Pure Water Flow : 200-250ml/min
» Cleaner, Healthier, Tastier
» Easily Replaceable Reminder
» Cartridge Replacement Reminder
» Pitcher Capacity : 2.8L
» Packing Dimension : 280x130x300mm

Water Pitcher

Calcium sulfite, Coconut carbon,
Soften resin, Mixed Resin



Ceramic Filter
The Ceramic Filter is made from a highly compressed ceramic diatomic substance
it is highly ressistant to heat as tested by professionals
The Ceramic Filter diameter is 0.2 micron (diameter of bacteria 0.5-1.0 micron)
The Function is to filter all dirt, sand, particles and bacteria to ensure thar your water
is free from any harmful diseases such as typhoid, cholera and dysentery

Multi-Stage Filter
This is the most advanced and efficient filter ever designed recently in the world
It needs only one filter to remove impurities such as bacteria, contaminants, chemical,
heavy metals etc, and yet retains all the good minerals and nutrients in the water
The filter provides you with clean and clear water, without unpleasant, taster or obnoxious odor
patented high technology, it blend 19 natural raw materials into one, at high pressure and temperature

Mineral Stone
This andesite contains various nourishing minerals such as potassium, sodium, calcium, and
magnesium and other micro elements which are essential for good helath

Magnetic Water Tap
The earth’s magnetic field generally promotes vitality for the human body. To Exploit this essence,
the outlet tap of water system is fitted with magnetic inline with the latest water technology
Magnetized water has free moving hexagonal structured water molecules in harmony with body fluids
Just like mineral spring water, it promotes helath and vitality, and imparts many therapeutic properties

MWF-1402
Capacity : 14L

Packing Dimension : 29x29x26cm

» 1st Stage : PP-10 PP Spun Fiber filter
» 2nd Stage : GAC-10 Granular Carbon Filter
» 3rd Stage : CTO-10 Bloack Carbon Filter
» 4th Stage : UF-10C Ultra Filter Membrane
» 5th Stage : T-33 Activated Carbon
» Packing Dimension : 400x170x450mm

Process

10" Disposable Cartridge - PP 5u + CTO
(PP 1u and GAC Available)
Packing Dimension : 560x380x370mm /6pcs

SST-2
10" Disposable Cartridge
(PP 1u, PP 5u, GAC, or CTO Available)
Packing Dimension : 370x470x570mm /12pcs

SST-1
10" Disposable Cartridge
(PP 1u, PP 5u, GAC, or CTO Available)
Packing Dimension : 370x470x570mm /12pcs

SST-1
10" Disposable Cartridge
PP 5u + GAC + CTO (PP 1u Available)
Packing Dimension : 430x800x370mm /6pcs

SST-3
10" Disposable Cartridge
(PP 1u, PP 5u, GAC, or CTO Available)
Packing Dimension : 208x145x360mm

NW-1
10" Disposable Cartridge - PP 5u + CTO
(PP 1u and GAC Available)
Packing Dimension : 345x145x360mm

NW-2
10" Disposable Cartridge
PP 5u + GAC + CTO (PP 1u Available)
Packing Dimension : 450x145x360mm

NW-3

10" Disposable Cartridge
(PP 1u, PP 5u, GAC, or CTO Available)
Packing Dimension : 140x140x340mm

NT-1
10" Disposable Cartridge - PP 5u + CTO
(PP 1u and GAC Available)
Packing Dimension : 290x145x340mm

NT-2
10" Disposable Cartridge
PP 5u + GAC + CTO (PP 1u Available)
Packing Dimension : 420x140x340mm

NT-3

10" Disposable Cartridge
(PP 1u, PP 5u, GAC, or CTO Available)
Packing Dimension : 500x300x360mm /8pcs

NT-1W
10" Disposable Cartridge - PP 5u + CTO
(PP 1u and GAC Available)
Packing Dimension : 590x310x350mm /4pcs

NT-2W
10" Disposable Cartridge
PP 5u + GAC + CTO (PP 1u Available)
Packing Dimension : 580x430x360mm /4pcs

NT-3W



10" Disposable Cartridge
(PP 1u, PP 5u, GAC, or CTO Available)
Packing Dimension : 170x140x350mm

US-1
10" Disposable Cartridge - PP 5u + CTO
(PP 1u and GAC Available)
Packing Dimension : 295x140x350mm

US-2
10" Disposable Cartridge - PP 5u + CTO
PP 5u + GAC + CTO (PP 1u Available)
Packing Dimension : 410x140x350mm

US-3

US-3+T33I (lodized Resin) or UV-6
Packing Dimension : 570x425x385mm /4pcs

US-4
US-3+T-33 (Activated Carbon)+T33I (Iodized Resin) or UV-6
US-3+UF Membrane + T33I (Iodized Resin)
Packing Dimension : 580x420x370mm /4pcs

US-5

10" Big Blue Cartridge (PP + CTO)
Packing Dimension :
210x200x430mm

WF-10B2
Water Filter

10" Big Blue Cartridge : 
(5umPP + CTO + 1umPP)
Packing Dimension :
210x200x430mm

WF-10B3
Water Filter

20" Big Blue Cartridge (PP + CTO)
Packing Dimension :
405x230x825mm

WF-20B2
Water Filter

20" Big Blue Cartridge
(5umPP + CTO + 1umPP)
Packing Dimension :
600x230x825mm

WF-20B3
Water Filter

Calcium Sulfite, KDF, Magnet
Activated Ceramic Ball
Packing Dimension :
420x420x370cm /50pcs

SF-02
Calcium Sulfite, KDF, Magnet
Activated Ceramic Ball
Packing Dimension :
420x420x370cm /50pcs

SF-02G
Coconut Carbon, KDF
Packing Dimension :
420x420x370cm /50pcs

SF-01
Coconut Carbon, KDF
Packing Dimension :
420x420x370cm /50pcs

SF-01G

» Calcium Sulfite & Vitamin C Balls
» Negative Ion Balls
» Germanium Balls
» Packing Dimension :
     540x440x310cm /25pcs

Filter Media

» Eliminates Chlorine in water supply to keep skin and hair helathy
» Vitamin C is released during the showering promoting healther skin
» Far infrared is released to improve waters dissolving and cleaning properties

Benefit

» Ensure hose is the correct size for new shower head before prceeding with installation
» Remove old shower head and connect new shower head to hose
» Recommended filter replacement interval is 3-6 months depending on usage

Usage



» High Filtration Precision
» Excellent Performance
» Simple Structure
» Easy Operation

Features

Installation Diagram

» Remove sand, Silt, and Rust Particles in water
» Solve the problem of secondary pollution
    in the distribution of city water pipeline network
    and turbidity of water in rural ground water

Filtration & Function

Model No.

Model No.

Water Source

Water Source

Suitable pressure

Suitable pressure

Water Flow

Water Flow

Water Inlet

Water Inlet

Purified water output

Purified water output

Drain Outfall

Drain Outfall

Filtration precision

Filtration precision

Rating temp

Rating temp

Packing Dimension

Packing Dimension

240 x 140 x 90 mm

215 x 115 x 100 mm

5~45˚C Suitable temperature : 5~45˚C

5~45˚C

½ inch

½ inch

½, ¾, 1 inch (DN20-25)
½, ¾, 1 inch (DN20-25)

PRF-02

PRF-01

City Water

City Water

1 bar ~ 8 bar

1 bar ~ 8 bar

40~90   m

40~90   m

3V = 2.6m /h (P =0.2 bar)3V = 4.2m /h (P =0.5 bar)

Parameter

Parameter

1000 L/H

½ inch
½ inch

Installation Diagram

» High Filtration Precision
» Excellent Performance
» Simple Structure
» Easy Operation

Features

» Remove sand, Silt, and Rust Particles in water
» Solve the problem of secondary pollution
    in the distribution of city water pipeline network
    and turbidity of water in rural ground water

Filtration & Function

» Prevents “brown” or “red” water and Clogged pipes,
    keeps pipe work clean

Siliphos Cartridges for Option

Water Output : 1000L /H
Packing dimension : 505x175x175 mm

Model No. : UF-1000
Three Stage Filtration, Direct Drinking Water



» Raw Water : Municipal Tap water
» Working Pressure : 0.15 - 0.5 Mpa
» Raw Water Temperature : 2 - 40
» Power : AC100-240V / 50-60Hz
» Inlet & Outlet : 3/4 inch
» Pure Water Flow : 1.5 m /h
» Net Weight (without salt) : < 20kg
» Machine Dimension : 347x347x625 mm

FCV-16-15
» Raw Water : Municipal Tap water
» Working Pressure : 0.15 - 0.5 Mpa
» Raw Water Temperature : 2 - 40
» Power : AC100-240V / 50-60Hz
» Inlet & Outlet : 3/4 inch
» Pure Water Flow : 1.5 m /h
» Net Weight (without salt) : < 20kg
» Machine Dimension : 347x347x625 mm

FCV-16-20

» LCD large screen with 7 languages available-English, Chinese,
    French, Russian, Spanish, Italian and German
» Measurement units optional (L, gal, m3)
» High quality resin tank with the characteristic of high
    temperature resistance
» With food grade ion exchange resin, Good performance,
    long lifespan
» Resin regeneration adjustable
» Adjustable resin regeneration mode/ raw water only/
    regeneration/ soft water only
» Machine Dimension : 347x347x625 mm

Features :

» Individual resin tank for Hot and Cold Water
» Single control valve allows you to choose between Soft Water, Source Water, or Shut Off
» High Quality and high efficiency resin
» Quick and simply regeneration
» No Separate brine tank required
» Packing Dimension : 540 x 380 x 160 mm

Features :

Installation Diagram



Installation diagram : Recommend to install the tap water main
pile and equipment in and out of water pipe

Power Adaptor

Continuous
Control Valve

Valve

Valve

Floor Drain

Salt Tank

Drain Pipe

Valve

Hard Water

Installation Construction

Softener Water

» Smart Regenration for efficient operation
» Digitally programmable
» Very easy to use

Features & Benefits
» Robust water Cabinet
» Digital Control Valve
» Compact Size

Item No. FCV-09-10 FCV-09-15 FCV-09-25
Regeneration Cycle
Default regeneration start time
Regeneration time
Inlet Water quality
Rating Flow
Optimal Working Pressure
Inlet Water Temperature
Power Supply
Resin Volume
Machine Dimension (L*W*H mm)

Packing Dimension (L*W*H mm)

Unit Weight

3 Days (Programmable)
2:00 (Programmable)

Approx 60 Minutes
Standard Municipal Water

< 0.5 ton /Hour
0.15-0.30 MPa

1-45°C
100~220V/ 50~60Hz

4 L
400x220x480

460x265x535

< 15 Kgs (Net Weight, not including Salt) < 20 Kgs (Net Weight, not including Salt) < 25 Kgs (Net Weight, not including Salt)

3 Days (Programmable)
2:00 (Programmable)

Approx 60 minutes
Standard Municipal Water

< 1.5 ton /hour
0.15-0.30 Mpa

1-45°C
110~220V/ 50~60Hz

6.5 L
400x220x590

460x265x670

3 Days (Programmable)
2:00 (Programmable)

Approx 60 minutes
Standard Municipal Water

< 2.5 ton /hour
0.15-0.30 Mpa

1-45°C
110~220V/ 50~60Hz

13 L
400x200x1045

460x265x1180

FCV-09-25FCV-09-15FCV-09-10

FCV-09-10(G)FCV-09-10(B)FCV-09-10(C)FCV-09-10(R)FCV-09-10(P)



FCV-11-10 FCV-11-15 FCV-11-25

FCV-11A-10 FCV-11A-15 FCV-11-25

Item No. FCV-11-10
FCV-11A-10

FCV-11-25
FCV-11A-25

FCV-11-15
FCV-11A-15

Regeneration Cycle
Default Regeneration Start Time
Regeneration Time

Inlet Water Quality
Rating Flow
Optimal Working Pressure

Inlet Water Temperature
Power Supply
Resin Volume
Machine Dimension (L*W*H mm)

Packing Dimension (L*W*H mm)

Unit Weight

3 Days (Programmable) 3 Days (Programmable) 3 Days (Programmable)
2:00 (Programmable) 2:00 (Programmable) 2:00 (Programmable)
Approx 60 minutes Approx 60 minutes Approx 60 minutes

Standard Municipal Water Standard Municipal Water Standard Municipal Water
< 0.5 Ton / Hour < 1.5 Ton / Hour < 2.5 Ton / Hour
0.15-0.30 MPa 0.15-0.30 MPa 0.15-0.30 MPa

1-45˚C 1-45˚C 1-45˚C
110~220V/50~60Hz 110~220V/50~60Hz 110~220V/50~60Hz

4 L 6.5 L 13 L
400x220x480 400x220x590 400x220x1045

460x265x535 460x265x670 460x265x1180

< 15 Kgs (Net Weight, not including Salt) < 20 Kgs (Net Weight, not including Salt) < 25 Kgs (Net Weight, not including Salt)

ZYF-01A ZYF-01B ZYF-02A ZYF-02B

» Imported Qualified KDF Filter Material Can
    Effectively Eliminate the deleterious heavy
    metal ion in water
» Qualified coal activated carbon filter material
    can Eliminate heterochromia and peculiar smell
» Quartz sand can remove particle substance
» To process water safe for drinking
» Great performance and long service life
» Convenient to be replaced with filters

Features :
» Imported Qualified KDF Filter Material Can
    Effectively Eliminate the deleterious heavy
    metal ion in water
» Qualified coal activated carbon filter material
    can Eliminate heterochromia and peculiar smell
» Quartz sand can remove particle substance
» To process water safe for drinking
» Great performance and long service life
» Convenient to be replaced with filters

Features :

Item No.
Housing Material
Source Water

Water Flow
Inlet Water Pressure
Suitable temp.

Filter Media
Control Valve
Product  Size

ZYF-02A / ZYF-02B
SS304
City Tap Water

1000L/H (2000~6000L/H for option)
0.15~0.3 Bar
5~45˚C

KDF+Coconut Carbon+Quartz Sand
Digital or Manual
Ø 264x1500mm

Item No.
Housing Material
Source Water

Water Flow
Inlet Water Pressure
Suitable temp.

Filter Media
Control Valve
Product  Size

ZYF-01A / ZYF-01B
SS304
City Tap Water

1000L/H (2000~6000L/H for option)
0.15~0.3 Bar
5~45˚C

KDF+Coconut Carbon+Quartz Sand
Digital or Manual
Ø 264x1550mm



KUSATSU

10" Disposable Cartridge - PP 5u + CTO
PP 5u + GAC + CTO (PP 1u Available) + UV
Packing Dimension : 580x420x370mm/4pcs

US-3U
10" Disposable Cartridge - PP 5u + CTO
(PP 1u and GAC Available) + UV
Packing Dimension : 580x300x370mm/4pcs

US-2U
» 1st Stage : PP-10 PP Spun Fiber Filter
» 2nd Stage : GAC-10 Granular Carbon Filter
» 3rd Stage : CTO-10 Block Carbon Filter
» 4th Stage : UV-6 Ultraviolet Water Sterilizer
» 5th Stage : T-33T2 ineral Ball
» Packing Dimension : 820x410x480mm/4pcs

US-3U
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» Packing Dimension : 50x38x74cm/18pcs
UV-4/6W

» Packing Dimension : 50x38x74cm/18pcs
UV-12W

» Packing Dimension : 100x56.5x10cm/5pcs
UV-35/55W

» Packing Dimension : 100x18x37cm/pcs
UV-110W With Electric Controller

» Packing Dimension : 100x18x37cm/pcs
UV-165W With Electric Controller

» Packing Dimension : 100x18x32.5cm/pcs
UV-165W With Shelf

UF Membrane
UF-10S

» Packing Dimension : 100x18x32.5cm/pcs
UV-110W With Shelf

» Packing Dimension : 99.5x36x43cm/6pcs
UV-35/55W With Shelf

» Packing Dimension - 25W : 65x38x43cm/6pcs
» Packing Dimension - 30W : 96.5x38x43cm/6pcs

UV-25/30W With Shelf

» With High Quality Plastic Shell
» Packing Dimension : 73.5x48.5x35.5cm/18pcs

UV-6P

» Packing Dimension : 46x36x37/6pcs
(Normal UV Lamp or Philips UV Lamp)

UV-16W

Packing Dimension :
340x340x360mm/25pcs

FILMTTEC
50GPD

Packing Dimension :
340x340x360mm/25pcs

FILMTTEC
75GPD

Packing Dimension :
340x340x360mm/25pcs

FILMTTEC
100GPD

» Permeate flow and salt rejection based on the following test conditions :
    250 ppm softened tapwater, 77˚F (25˚C), 50 psig (3.4 Bar), & 15% Recovery
» Permeatr flow rates for indivudual elements may vary +/-20%

Product Name Permeate Flow
3Rate gpd (m /d)

FILMTEC
TW30-1812-50

FILMTEC
TW30-1812-75

FILMTEC
TW30-1812-100

Stabilized Salt
Rejection (%)

50 (0.19)

75 (0.28)

100 (0.38)

98.0

98.0

98.0

Minimum Salt
Rejection (%)

98.0

98.0

98.0

Model NF-1812-150

Performance

Tset Condition

Operating Limit

Average Rejection (%)
Permaetae Flux GPD

2 2Active Area ft  (m )
Membrane Bag Number
Test Pressure
Test Temp
NaCl Concentration (ppm)
PH
Recovery (%)
Max Pressure
Max Feed Flow Rate
Max Operating Temp.
Max SDI (Inlet)
Free Chlorine Tolerance
PH Range (Continuous Operation)
PH Range (Chemical Cleaning)
Single Membrane element maximum pressure drop

Single Membrane element water output may change within -/+ 20%
Dry Membrane element storage temperature not higher than 45˚C

NF-2012-250 NF-2812-500 NF-3012-600

UF Membrane
UF-10C

Bayonet Cartridge
UF Membrane Inside

UF-10F
Quick Fitting Build-in
UF Membrane
UF Membrane Inside

UF-10Q

Water Flow 2.5 L/M
Test Temp. 25˚C
Test Pressure 0.1Mpa
Packing Dimension :
690x260x350mm/50pcs

Water Flow 2.5 L/M
Test Temp. 25˚C
Test Pressure 0.1Mpa
Packing Dimension :
690x620x410mm/200pcs

Water Flow 2.0 L/M
Test Temp. 25˚C
Test Pressure 0.1Mpa
Packing Dimension :
370x370x295mm/25pcs

Water Flow 2.0 L/M
Test Temp. 25˚C
Test Pressure 0.1Mpa
Packing Dimension :
340x340x360mm/25pcs



KUSATSU 80 G

PERINGATAN !! Gunakan selalu membran KUSATSU asli untuk menghindari kerusakan
 pada mesin Reverse Osmosis Anda, Membran KUSATSU asli hanya bisa didapatkan di : 
PT. Indotara Persada - Phone. 021 - 5020 3030 - Website. www.indotara.co.id

5 2 0 1 5 4 2 1

KUSATSU 80 G

PERINGATAN !! Gunakan selalu membran KUSATSU asli untuk menghindari kerusakan
 pada mesin Reverse Osmosis Anda, Membran KUSATSU asli hanya bisa didapatkan di : 
PT. Indotara Persada - Phone. 021 - 5020 3030 - Website. www.indotara.co.id

5 2 0 1 5 4 2 1

KUSATSU 125 G

PERINGATAN !! Gunakan selalu membran KUSATSU asli untuk menghindari kerusakan
 pada mesin Reverse Osmosis Anda, Membran KUSATSU asli hanya bisa didapatkan di : 
PT. Indotara Persada - Phone. 021 - 5020 3030 - Website. www.indotara.co.id

5 2 0 1 5 4 2 1

KUSATSU 80 G

PERINGATAN !! Gunakan selalu membran KUSATSU asli untuk menghindari kerusakan
 pada mesin Reverse Osmosis Anda, Membran KUSATSU asli hanya bisa didapatkan di : 
PT. Indotara Persada - Phone. 021 - 5020 3030 - Website. www.indotara.co.id

5 2 0 1 5 4 2 1

KUSATSU 80 G

PERINGATAN !! Gunakan selalu membran KUSATSU asli untuk menghindari kerusakan
 pada mesin Reverse Osmosis Anda, Membran KUSATSU asli hanya bisa didapatkan di : 
PT. Indotara Persada - Phone. 021 - 5020 3030 - Website. www.indotara.co.id

5 2 0 1 5 4 2 1

KUSATSU 125 G

PERINGATAN !! Gunakan selalu membran KUSATSU asli untuk menghindari kerusakan
 pada mesin Reverse Osmosis Anda, Membran KUSATSU asli hanya bisa didapatkan di : 
PT. Indotara Persada - Phone. 021 - 5020 3030 - Website. www.indotara.co.id

5 2 0 1 5 4 2 1

KUSATSU 125 G

PERINGATAN !! Gunakan selalu membran KUSATSU asli untuk menghindari kerusakan
 pada mesin Reverse Osmosis Anda, Membran KUSATSU asli hanya bisa didapatkan di : 
PT. Indotara Persada - Phone. 021 - 5020 3030 - Website. www.indotara.co.id

5 2 0 1 5 4 2 1

KUSATSU 80 G

PERINGATAN !! Gunakan selalu membran KUSATSU asli untuk menghindari kerusakan
 pada mesin Reverse Osmosis Anda, Membran KUSATSU asli hanya bisa didapatkan di : 
PT. Indotara Persada - Phone. 021 - 5020 3030 - Website. www.indotara.co.id

5 2 0 1 5 4 2 1

» Double O-Ring
» RO Membrane Housing
    For 50, 75, 80, 100, 125GPD

ROH-10B
» Single O-Ring
» RO Membrane Housing
    For 200, 300GPD

ROH-10BB
» KUSATSU-50G-Q
» KUSATSU-75G-Q
» KUSATSU-100G-Q
» KUSATSU-150G-Q
» Packing Dimension : 340x340x345mm/25pcs

Quick Fitting RO Membrane Cartridge
» KUSATSU-50G-Q2
» KUSATSU-75G-Q2
» KUSATSU-100G-Q2
» Packing Dimension : 34x34x36cm/25pcs

Quick Fitting RO Membrane

Item No.

Dimension

50G/75G/80G/90GG/
100G/125G/150G
31x31x32cm/25pcs

200G/300G/400G

34x34x36cm/16pcs

KUSATSU ‘TORAY ’RO Membrane Model Data Sheet
Model

50G 75G 80G80G 90G 100G 125G 150G 200G 300G 400G

Kusatsu ‘TORAY’ RO Membrane Kusatsu ‘TORAY’ RO Membrane



» Temperature : 5~45˚C
» Service Life : 5000L
» Flow : 3L/Min
» Pressure : 0.1~1.5Mpa

T33-10CF
» Temperature : 5~45˚C
» Service Life : 4000L
» Flow : 0.38L/Min
» Pressure : 0.1~1.5Mpa

RO-10CF
» Temperature : 5~45˚C
» Service Life : 5000L
» Flow : 3L/Min
» Pressure : 0.1~1.5Mpa

UF-10CF
» Temperature : 5~45˚C
» Service Life : 5000L
» Flow : 2L/Min
» Pressure : 0.1~1.5Mpa

MTP-10CF

» Temperature : 5~45˚C
» Service Life : 5000L
» Flow : 3L/Min
» Pressure : 0.1~1.5Mpa

PP-10CF
» Temperature : 5~45˚C
» Service Life : 5000L
» Flow : 3L/Min
» Pressure : 0.1~1.5Mpa

GAC-10CF
» Temperature : 5~45˚C
» Service Life : 5000L
» Flow : 3L/Min
» Pressure : 0.1~1.5Mpa

CTO-10CF

» PP Sediment
» Packing Dimension :
    38x38x31cm/25pcs
» 2" or 3" Connection
    for Option

PP-10F
» UF Cartridge
» Packing Dimension :
    38x38x31cm/25pcs
» 2" or 3" Connection
    for Option

UF-10F
» Granular Carbon
» Packing Dimension :
    38x38x31cm/25pcs
» 2" or 3" Connection
    for Option

GAC-10F

» Packing Dimension :
    38x38x31cm/25pcs
» 2" or 3" Connection
    for Option

GAC-10F (C)
» RO Cartridge
» Packing Dimension :
    38x38x31cm/25pcs
» 2" or 3" Connection
    for Option

RO-10F
» Block Carbon
» Packing Dimension :
    38x38x31cm/25pcs
» 2" or 3" Connection
    for Option

CTO-10F



» Quick Fitting
» PP Sediment
» Packing Dimension
    34x34x36cm/25pcs

PP-28
» Quick Fitting
» Garnular Carbon
» Packing Dimension
    34x34x36cm/25pcs

GAC-28
» Quick Fitting
» Block Carbon
» Packing Dimension
    34x34x36cm/25pcs

CTO-28
» Quick Fitting
» Activated Carbon
» Packing Dimension
    34x34x36cm/25pcs

T33-28

» Quick Fitting
» Medical Stone
» Packing Dimension
    34x34x36cm/25pcs

T28T1
» Quick Fitting
» Mineralized Balls
» Packing Dimension
    34x34x36cm/25pcs

T28T2
» Quick Fitting
» UF Membrane
» Packing Dimension
    34x34x36cm/25pcs

UF-10Q2

» Quick Fitting
» RO Membrane
» Packing Dimension
    34x34x36cm/25pcs

KUSATSU-50G-Q2
KUSATSU-75G-Q2
KUSATSU-100G-Q2

» Quick Fitting
» PP Sediment
» Packing Dimension
    340x340x360mm/25pcs

PP-33
» Quick Fitting
» Garnular Carbon
» Packing Dimension
    340x340x360mm/25pcs

GAC-33
» Quick Fitting
» Block Carbon
» Packing Dimension
    340x340x345mm/25pcs

CTO-33
» Quick Fitting
» Activated Carbon
» Packing Dimension
    368x368x302mm/25pcs

T33-33

» Activated Carbon
» Packing Dimension
    340x340x305mm/25pcs

T-33B1
» PP Sediment
» Packing Dimension
    340x340x305mm/25pcs

T-33B3
» Resin
» Packing Dimension
    368x368x302mm/25pcs

T-33B5
» Coconut Carbon
» Packing Dimension
    368x368x302mm/25pcs

T-33B6

» Iodized Resin
» Packing Dimension
    368x368x302mm/25pcs

T-33I
SPECIFICATION
» Flow : 0.75gpm (2.8Lpm)
» Pressure : 30-125psi
» Service Life : 2500L
» Temperature : 4.5-37.8˚C
» Sterilization Rate : 99.99%

Specification

Kills Viruses and bacteria with a 99.99%
sterilization rate preventing secondary
pollution of purified water

IODIZED RESIN

Absorb residual chlorine and adjusts
taste and odor

COCONUT CARBON



PP Spun Fiber
» 10" PP Spun Fiber Cartridge
» For Big Blue Housing
» Packing Dimension
    59x24x53cm/20pcs

PP-10B

» 20" PP Spun Fiber Cartridge
» Packing Dimension
    59x24x53cm/25pcs

PP-20

» 40" PP Spun Fiber Cartridge
» Packing Dimension
    33x33x102cm/25pcs

PP-40

» 10" PP Spun Fiber Cartridge
» Packing Dimension
    33x33x53cm/50pcs

PP-10-T

» 10" PP Spun Fiber Cartridge
» Packing Dimension
    33.5x33.5x53cm/50pcs

PP-10

» 30" PP Spun Fiber Cartridge
» Packing Dimension
    33x33x77cm/25pcs

PP-30

» 10" PP Spun Fiber Cartridge
» Packing Dimension
    33x33x53cm/50pcs

PP-10-X

» 5" PP Spun Fiber Cartridge
» Packing Dimension
    34x34x54cm/100pcs

PP-5

» 20" PP Spun Fiber Cartridge
» For Big Blue Housing
» Packing Dimension
    59x24x53cm/10pcs

PP-20B

Block Carbon
» 20" Block Carbon Cartridge
» For Big Blue Housing
» Packing Dimension
    36x25x53cm/6pcs

CTO-20B
» 4" Block Carbon Cartridge
» Packing Dimension
    38x38x20cm/25pcs

CTO-04

» 5" Block Carbon Cartridge
» Packing Dimension
    38x38x28cm/25pcs

CTO-5

» 7" Block Carbon Cartridge
» Packing Dimension
    38x38x30cm/25pcs

CTO-7

» 10" Block Carbon Cartridge
» Packing Dimension
    38x38x28cm/25pcs

CTO-10

» 10" Block Carbon Cartridge
» For Big Blue Housing
» Packing Dimension
    36x25x53cm/12pcs

CTO-10B

» 20" Block Carbon Cartridge
» Packing Dimension
    53x39x31cm/20pcs

CTO-20

Granular Carbon Cartridge
» 10" Granular Carbon Cartridge
» Packing Dimension
    39x39x28cm/25pcs

GAC-103

» 10" Granular Carbon Cartridge
» Packing Dimension
    39x39x28cm/25pcs

GAC-10E

» 20" Granular Carbon Cartridge
» Packing Dimension
    53x39x31cm/20pcs

GAC-20

» 5" Granular Carbon Cartridge
» Packing Dimension
    39x39x28cm/50pcs

GAC-5

» 10" Granular Carbon Cartridge
» Packing Dimension
    33x28x53/40pcs

GAC-10S

» 10" Granular Carbon Cartridge
» For Big Blue Housing
» Packing Dimension
    36x25x53cm/12pcs

GAC-10B

» 20" Granular Carbon Cartridge
» For Big Blue Housing
» Packing Dimension
    36x25x53cm/6pcs

GAC-20B

» 20" Granular Carbon Cartridge
» Packing Dimension
    53x39x31cm/20pcs

GAC-202

» 10" Granular Carbon Cartridge
» Packing Dimension
    38x38x28cm/25pcs

GAC-10

» 10" Granular Carbon Cartridge
» Packing Dimension
    39x39x28cm/25pcs

GAC-104

» 10" Granular Carbon Cartridge
» Packing Dimension
    40x30x26cm/20pcs

GAC-102

» 20" Granular Carbon Cartridge
» Packing Dimension
    39x33x55cm/20pcs

GAC-20S

PP Yarn Cartridge
» 10" PP Yarn Cartridge
» For Big Blue Housing
» Packing Dimension
    59x24x53cm/20pcs

PS-10B

» 40" PP Yarn Cartridge
» Packing Dimension
    33x33x102cm/25pcs

PP-40

» 10" PP Yarn Cartridge
» Packing Dimension
    33x33x53cm/50pcs

PS-10

» 30" PP Yarn Cartridge
» Packing Dimension
    33x33x77cm/25pcs

PS-30

» 5" PP Yarn Cartridge
» Packing Dimension
    33x33x53cm/100pcs

PS-5

» 20" PP Yarn Cartridge
» For Big Blue Housing
» Packing Dimension
    59x25x53cm/10pcs

PS-20B

» 20" PP Yarn Cartridge
» Packing Dimension
    33x32x53cm/25pcs

PS-20

Pleated Cartridge
» 10" Pleated Cartridge
» Packing Dimension
    39x39x53cm/50pcs

PL-101

» 20" Pleated Cartridge
» For Big Blue Housing
» Packing Dimension
    39x39x53cm/9pcs

PL-20B

» 10" Pleated Cartridge
» For Big Blue Housing
» Packing Dimension
    39x39x53cm/18pcs

PL-10B01

» 20" Pleated Cartridge
» Packing Dimension
    33x33x53cm/25pcs

PL-20

» 10" Pleated Cartridge
» Packing Dimension
    33x33x53cm/50pcs

PL-10

» 10" Pleated Cartridge
» For Big Blue Housing
» Packing Dimension
    39x39x53cm/18pcs

PL-10B

MIC Pleated Cartridge
» 10" MIC Pleated Cartridge
» Packing Dimension
    39x39x28cm/20pcs

MIC-102

» 20" MIC Pleated Cartridge
» Packing Dimension
    38x38x53cm/25pcs

MIC-20R

» 10" MIC Pleated Cartridge
» Packing Dimension
    39x39x28cm/25pcs

MIC-101

» 10" MIC Pleated Cartridge
» Packing Dimension
    39x39x28cm/25pcs

MIC-10

» 10" MIC Pleated Cartridge
» Packing Dimension
    39x39x28cm/25pcs

MIC-10S

» 10" MIC Pleated Cartridge
» Packing Dimension
    39x39x28cm/25pcs

MIC-10R

» 20" MIC Pleated Cartridge
» Packing Dimension
    38x38x53cm/25pcs

MIC-20



» 10" Grooved Cartridge
    Grooved By Cutter
» Packing Dimension
    33x33x53cm/50pcs

CPP-10
» 10" PP Spun Fiber and
    Granular Carbon Cartridge
» Packing Dimension
    38x38x28cm/25pcs

PUDF-101
» 10" Carbon Fiber Cartridge
» Packing Dimension
    33x28x53cm/20pcs

FR-10
» 10" Activated Carbon
» Filter Cartridge
» Packing Dimension
    38x38x28cm/25pcs

ION-102(C)
» 10" Resin Filter Cartridge
» Packing Dimension
    38x38x28cm/25pcs

ION-102
» 20" Resin Filter Cartridge
» Packing Dimension
    53.5x39x32cm/20pcs

ION-102
» 10" Resin Filter Cartridge
» Packing Dimension
    39x39x38cm/25pcs

ION-101
» 10" PP Spun Fiber and
    Granular Carbon Cartridge
» Packing Dimension
    38x38x28cm/25pcs

PUDF-102

» 10" Ceramic Filter
» Packing Dimension
    33x33x53cm/50pcs

CE-101
» 10" Ceramic Filter
CE-102S

» PH Filter Cartridge
» Packing Dimension
    50x34x25cm/40pcs
» PH-10 : Empty
» PH-10A : Alum inside
» PH-10B : Siliphos Inside

PH-10
» 5" Net Filter Cartridge
» Packing Dimension
    33x33x53cm/100pcs

SFC-5
» 10" Net Filter Cartridge
» Packing Dimension
    33x33x53cm/50pcs

SFC-10
» 10" Siliphos Cartridge
» Packing Dimension
    38x38x28cm/25pcs

SP-10
» 10" Ceramic Filter
» Packing Dimension
    49x31x32cm/40pcs

CE-104
» 10" Ceramic Filter
» Packing Dimension
    33x28x53cm/20pcs

CE-103

» PP Sediment
» Packing Dimension
    27x27x27cm/25pcs

T-33P
» Activated Carbon
» Packing Dimension
    27x27x27cm/25pcs

T-33C
» Magnet Inside
T-33M

» Activated Carbon
» Packing Dimension
    27x27x27cm/25pcs

T-33
» Quick Fitting
» Alkaline Mineralized Balls
» Packing Dimension
    27x27x27cm/25pcs

T-33Q(A)
» Quick Fitting
» Activated Carbon
» Packing Dimension
    27x27x27cm/25pcs

T-33Q
» Mineral Ball
» Packing Dimension
    27x27x27cm/25pcs

T-33T2

» Acid-Washed
    Bloack Carbon
» Packing Dimension
    29x29x29cm/25pcs

T-33S
» Activated Carbon
» Packing Dimension
    27x27x27cm/25pcs

T-33T3
» Activated Ceramic Ball
T-22B

» Far Infrared Cartridge
» Packing Dimension
    39.5x39.5x33.5cm/25pcs

T-33F1
» Far Infrared Cartridge
» Packing Dimension
    27x27x27cm/25pcs

T-33E
» Mineral Stone
» Packing Dimension
    27x27x27cm/25pcs

T-33T1

Antiscale Ratio

Alkalinity
95.3%

3.87mmol/L
90.3%

5.28mmol/L
70%

6.45mmol/L
3. Testing Water Hardness : 600mg/L

Antiscale Ratio

Alkalinity
87%

3.87mmol/L
77.7%

5.28mmol/L
71.3%

6.45mmol/L
2. Testing Water Hardness : 300mg/L

Antiscale Ratio

Alkalinity
92%

3.87mmol/L
83.3%

5.28mmol/L
77.9%

6.45mmol/L

1. Testing Water Hardness : 240mg/L
    (Water Hardness is 240mg/L, Alkalinity : 4.46mmol/L)

Comparison of Boiling Water Before and After Using Nano Antiscl Carbon :

Comparison of Water Before and After Using Nano Antiscl Carbon :

1. Testing Water Hardness : 300mg/L, Testing Water Phenolphtalein Alkalinity : 2.0 mmol/L
    Compaarison of Water Before and After Using Nano Antiscale Carbon

(The Left one is Tap Water,
the Right One is Water Filtered by Nano Antiscale Carbon)

2. Testing Water Hardness : 450mg/L, Testing Water Phenolphtalein Alkalinity : 2.0 mmol/L

(The Left one is Tap Water,
the Right One is Water Filtered by Nano Antiscale Carbon)

Antiscale Ratio

Total Hardness of Raw Water
95.3%

300mg/L
90.7%

450mg/L

» Material Nano Antiscale Carbon CTO-10
» Function : Remove the Odorous odor, Residual Chlorine, Colloids
                        and suspended solids in the Water and remove the scale
» Technical Parameters :
    Water hardness < 600mg/L
    Inlet Water Temperature : 5-45˚C
» Pure Water Flow : 2L/min
» Rated Water Flow : 2500L
» Suggested Replacement Time : 6 Months

Features





Mineral Stone Adjusted level of mineral to
water that has had all its mineral substances
removed throught RO Filtration

Far Infrared Mineralized Balls Emit Small
Amounts of Far Infrared to Improve Water
Quality and Odor

Quartz is used as a stable, wear proof filter
media

SiliPhos is Used to Protect Water Pipeline
Systems from Corrosion

Ion Exchange Resin Removes Calcium and
Magnesium Ions to Generate Soft Water

KDF is Used to treat heavy metal impurity
and Organic Pollution in water

Coal Carbon is a Filter Media That Removes
any Organics, Chlorine, Odor and Turbidity
in Water

Coconut Carbon is a Filter Media That
Removes any Organics, Chlorine, Odor and
Turbidity in Water

Alkaline Mineral Balls, Adjust PH Valve to
Alkaline, Which is Good for human body
health

BP-01 50G

BP-01 100G

BP-01 300G

Model Voltage
(V)

Current
(A)

Inlet Water Pressure
(PSI)

Outlet Water Pressure
(PSI)

Flow Rate
(ML/M) Remark

BP-01 75G

BP-01 400G

BP-01 200G

PumpPump
Booster Pump Technical Parameter
Environmental Temperature > 16˚C Temperature : 25˚C » Booster Pump

» Packing Dimension
    40x33x12.5mm/6pcs

BP-01

» Goose Faucet with Plastic
» Spout and Plastic Handle
» Packing Dimension
    50x31x38mm/50pcs

GF-01

» Adaptor
» Input : 110V/220V
» Output : DC24V
» Frequency : 50/60Hz

QAD-01

Pump Head Spare Parts and Fixing Sketch

» Goose Faucet with Chrome
» Spout and Plastic Handle
» Packing Dimension
    50x31x38mm/50pcs

GF-01C
» Goose Faucet with Gold
» Spout and Plastic Handle
» Packing Dimension
    50x31x38mm/50pcs

GF-01G
» Goose Faucet with Chrome
» Spout and Plastic Handle
» Packing Dimension
    48x35x35mm/40pcs

GF-02C
» Goose Faucet with Chrome
» Spout and Chrome Handle
» Packing Dimension
    47.5x34x39.5mm/40pcs

GF-02S

» Goose Faucet with Gold
» Spout and Gold Handle
» Packing Dimension
    48x35x34mm/40pcs

GF-02G
» Goose Faucet with Chrome
» Spout and Chrome Handle
» Packing Dimension
    59x37x44mm/50pcs

GF-03C
» Goose Faucet with Chrome
» Spout and Chrome Handle
» Packing Dimension
    55x36x33mm/30pcs

GF-04C
» Dual Function Faucet
» Packing Dimension
    55x36x33mm/30pcs

GF-05
» Packing Dimension
    55x36x33mm/30pcs

GF-06
» Packing Dimension
    48x37x71mm/50pcs

GF-06S

» Luxury Kitchen Faucet
» Packing Dimension
    39x18.5x6.5cm/30pcs

GF-09
» Luxury Kitchen Faucet
    (For Tap Water & RO Water)
» Packing Dimension :
    40x21x9cm/30pcs

GF-08
» Dual Function Faucet
» Packing Dimension :
    39x17.5x3.5cm/30pcs

GF-07

» Packing Dimension :
    20x20x35cm/1pc

2.5G Smart Tank
» Packing Dimension :
    28x28x42cm/1pc

3.0G Plastic Tank
» Packing Dimension :
    28x28x42cm/1pc

4.0G Plastic Tank
» Packing Dimension :
    20x20x35cm/1pc

2.0G Steel Tank
» Packing Dimension :
    24x24x36.5cm/1pc

2.8G Steel Tank
» Packing Dimension :
    28x28x42cm/1pc

3.0G Steel Tank
» Packing Dimension :
    28x28x38cm/1pc

3.2G Steel Tank

» Packing Dimension :
    32x32x56cm/1pc

6.0G Steel Tank
» Packing Dimension :
    42x42x60cm/1pc

11G Steel Tank
» Packing Dimension :
    42x42x82cm/1pc

20G Steel Tank
» Packing Dimension :
    42x42x103cm/1pc

28G Steel Tank
» Packing Dimension :
    45x45x89cm/1pc

28G Steel Tank
» Packing Dimension :
    49x49x104cm/1pc

28G Steel Tank



124 Series Housing Wrench
This is suitable for 124-10

WR-01
RO Housing Wrench
This is suitable for 122-10

WR-02
Table Water Filter Wrench
This is suitable for FT-1

WR-04
Membrane Housing Wrench
for 50G, 75G, 100G Membrane Housing

WR-05
Membrane Housing Wrench
for N03, N03F Membrane Housing

WR-07
Membrane Housing Wrench
for 200G, 300G Membrane Housing

WR-06

Clamp
2.5" x 2.5"

CL-03
Clamp
2" x 2"

CL-07
Clamp

2" x 2.5"

CL-04
Clamp

2" x 3.5"

CL-04B
Clamp

2.5"

CL-05
Clamp

3.5"

CL-05B
Clamp

2"

CL-06

L: 8cm, W: 6cm, H: 10cm
This is Suitable for NT-1 122-20

HG-0104
L: 19cm, W: 10cm, H: 4cm
This is Suitable for NT-2

HG-0205
L: 30cm, W: 11cm, H: 11.5cm
H1: 8.5cm, H2: 3.5cm

ROG-FFC
L: 36cm, W: 16cm, 
H1: 14cm, H2: 4cm

ROG-FFB
L: 26cm, W: 15cm, 
H1: 14cm, H2: 3.5cm
This is Suitable for RO-4

ROG-0201
L: 36cm, W: 15cm, 
H1: 14cm, H2: 3.5cm
This is Suitable for WP-1
/ WP-2/ RO-50G-E01

ROG-0304
L: 11.8cm, W: 5.5cm, H: 44.5cm
This is Suitable for Housing 121

HGP-018

L: 25cm, W: 10.8cm,
H1: 4.6cm, H2: 3.5cm
This is Suitable for US-2

HG-0201
L: 36cm, W: 15cm,
H1: 4cm, H2: 1.5cm
This is Suitable for NT-3

HG-0305
L: 36cm, W: 17.5cm,
H1: 41cm, H2: 3cm
This is Suitable for RO-50G Series

ROG-0301H (Black)
L: 36cm, W: 17.5cm,
H1: 14cm, H2: 3cm
This is Suitable for RO-50G Series

ROG-0301Y (Silver)
L: 11.5cm, W: 6cm, H: 11cm
This is Suitable for Housing 126

HGP-126

L: 13.5cm, W: 12.8cm,
H1: 5cm, H2: 5cm
This is Suitable for NW-1

HG-0102A
L: 25cm, W: 12.8cm,
H1: 4cm, H2: 3.2cm
This is Suitable for NW-2

HG-0203A
L: 36cm, W: 12.8cm,
H1: 4cm, H2: 3.5cm
This is Suitable for NW-3

HG-0301A
L: 36cm, W: 17cm,
H1: 14cm, H2: 3cm
This is Suitable for RO-50G Series

ROG-0301L (White)
Faucet Bracket

LT-01

L: 36cm, W: 12.8cm,
H1: 4cm, H2: 3.5cm
This is Suitable for US-3

HG-0303
Dustproof Cover

DC-1



1/2", 3/8" Tube
Diverter Valve

VA-01
1/2", 3/8" Tube
Diverter Valve

VA-02
1/2", 3/8" Tube
Diverter Valve

VA-03
1/2"

Diverter Valve

VA-08
1/2", 1/2" or 3/4", 3/4"
Diverter Connector

FC-04

1/4"
Diverter Valve

AVA-02Q
1/4", 1/4"

Chromed Mixing Valve

MV-01M
1/4" RO Tube, 1/4" RO Tube

Chromed Mixing Valve

MV-02M
1/2", 3/4"

Diverter Connector

VA-09
1/2", 3/4"

Diverter Connector

VA-09B

3/4", 3/4", 1/4"
Diverter Valve

MF-02
3/8", 3/8", 1/4"
Diverter Valve

MF-02A
3/4", 3/4", 1/4"
Diverter Valve

MF-02B
1/2", 1/2", 1/4"
Diverter Valve

MF-01
3/8", 3/8", 1/4"
Diverter Valve

MF-02S
3/4", 1/4"

Diverter Valve

MF-03
1/2", 1/2", 1/4"
Diverter Valve

MFV-01

1/4", 1/2", 1/4 Tube
Diverter Valve

MFV-02
1/4", 3/8" Tube

Metal Connector

CT-01
1/4", 3/8" Tube

Metal Connector

CT-02
1/4", 3/8" Tube

Metal Connector

CT-03
1/4", 1/4" Tube

Pressure Reduce Valve

PRV-2
1/4", 1/4" Tube

Pressure Reduce Valve
(Quick Fitting)

PRV-3

TF-450 TF-300
Plastic Flow - Limit Valve

TDS-3
TDS Meter

ST-1
Seal Tape

TF-450M TF-300M TF-1200M
Metal Flow - Limit Insert

LP-1
Leakage Protection

CLM-5
Drain Clamp

SL-07
Valve Base Groupware

TRG-3
Pump Diaphragms

CB-1
Lamp Indicator IC Controller

CB-2
LCD IC Controller

CB-3
Digital IC Controller

CB-4
Digital TDS IC Controller

CB-5
LCD IC Controller

SVA-827-1
1/8" Solenoid Valve

SVA-827-2
1/4" Solenoid Valve

SVA-827-3
Solenoid Valve

With Flow-Limit Valve

SVA-826-1
Auto Flush Solenoid Valve

SVA-826-2
Auto Flush Solenoid Valve

With Flow-Limit Valve

VA-05
Feed Water Valve
1/4" Outer Pitch
1/4" Inner Pipe

VA-06
Feed Water Valve
1/4" Outer Pitch
3/8" Inner Pipe

TR-420-2

Water Electrolyzer

SVA-824

Selenoid Valve

SVA-825

Selenoid Valve

PSH-700
High Pressure Switch

PSH-800
Low Pressure Switch

FL-505
Float Switch

FL-506
Float Switch

FL-507
Float Switch

ASV-408
Auto Shut-Off Valve



Model : HZ-JCX Packing Dimension : 240x240x60mm

Tool Name QtySerialNumber
1
2
3
4
5
6
7
8
9
10
11
12
13
14

1
1
1
4
4
2
2
1
1
1
1
1
1
1

UF-8000 WP-24000 QGF-100

WST-01 MRS-1-T SMN-3000 SW-HZ1 EDI IT-6000

Provide Best Designs, Solutions & Equipment for Any Water

For more details, Please refer to our industrial edition


